Crash course 

till

Eagle 4
Easily Applicable Graphical Layout Editor

Inledning

Eagle är ett program där man smidigt kan designa sina egna kretskort. I denna manual kommer jag att ge en funktionsbeskrivning för hur man använder programmet på ett enkelt sätt. 

Starta programmet
För att skapa en ny PCB-layout så väljer du File > New > Board. Nu kommer det fönster upp som du ska designa ditt kretskort i. Det fösta du ska göra nu är att du ska se till att fönstret är maximerat, så att du får en stor arbetsyta.

Placera ut komponenter
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Till vänster ser du nu en verktygsmeny. Leta upp knappen som ser ut så här:

	Komponent
	Grupp

	Resistorer
	rcl

	Kondensatorer
	Capacitor-wima

rcl

	Dioder
	diode

	Lysdioder
	led

	Spolar
	rcl

	Likriktarbryggor
	rectifier

	Transistorer
	Transistor-npn

Transistor-pnp

	Relän
	relay

	Potentiometrar
	pot

	74-kretsar (DIL)
	74xx-eu


När du har tryckt på denna knapp så kommer det komma upp ett fönster med en lista över tillgängliga komponenter. Alla komponenter är indelade i grupper, t.ex. så kan du hitta alla resistorer i gruppen ”rcl”. Här till höger så kan du hitta en lista över vad de vanligaste komponenterna ligger i för grupper. Testa nu att öppna några grupper och klicka på några komponenter. Notera att du ser en förhandsgranskning av komponenten. När du har bestämt dig för en komponent som du vill använda så klickar du bara på OK. 

Nu har du kommit tillbaka till din arbetsyta och som du redan säkert har märk så ser du den komponent som du valde på skärmen. För att placera ut komponenten så rör du musen dit du vill ha den (vill du rotera på komponenten så högerklickar du) och klickar sedan på musens vänsterknapp. 
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Som du ser så är den komponent som styrs av musen kvar, detta ifall du vill placera ut ytterligare komponenter. Vill du inte det så klickar du på:
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Tips: Vill du placera ut flera olika komponenter efter varandra så trycker du på escape-tangenten istället för att klicka på 

Tips: För att veta vilken av komponenterna i listan man ska välja så finns det två sätt. Det ena är att du slår upp komponenten i ELFA och läser av längd mellan benen och kapselns kod. Den andra metoden är att du placerar ut ett antal komponenter med olika storlekar och sedan skriver ut den på ett vanligt papper. Du kan då testa med din komponent vilken storlek som passar bäst.

Redigera utplacerade komponenter
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Oftast så kommer man att behöva flytta, rotera eller ta bort några av de komponenter man har placerat ut. Detta gör du genom att klicka på 
och sedan klicka på komponenten. Observera att alla komponenter har ett vitt kryss i mitten och att det är där du ska klicka. Nu kommer komponenten att flytta sig med musen, vill du rotera den så högerklickar du.

För att radera en komponent så klickar du på [image: image8.png]


       varpå du vänsterklickar på komponenten.

Namngivning av komponenter
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Det går att ange både ett namn och ett värde på de flesta komponenterna. Det är viktigt eftersom det annars kan bli svårt att veta vilka komponenter som motsvarar varandra på kopplingsschemat. Du anger namnet och värde med hjälp av dessa knappar i det vänstra verktygsfältet. Efter att du har tryckt på t.ex. 
    för att ändra namnet så ska du vänsterklicka på komponenten. Det kommer då upp en ruta där du kan skriva in namnet. 
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Samma procedur gäller för ändring av värdet

Markera / Kopiera / Klistra in
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För att kopiera en komponent så måste du först markera den. Den gör du med verktyget Group        Se nu till att du har minst en komponent utplacerad. Sedan trycker du på group och trycker på musens vänsterknapp samtidigt som du förflyttar musen. Se till att komponenterna är inom den streckade fyrkant som bildas. När en komponent är markerad så får den en ljusare färg.
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För att sedan kopiera en eller flera komponenter så trycker du på 
      varpå du vänsterklickar på komponenten du ska kopiera.

Gissningsvis så är du även intresserad av att kunna klistra in den komponent du nu har kopierat, och detta gör du med knappen Paste [image: image14.png]


       Efter det att du tryckt på paste så placerar du ut komponenten med vänster musknapp.

Zoomning
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Zoomning in/ut av din arbetsyta sker med hjälp av dessa knappar som finns i verktygsfältet vid toppen av skärmen.
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Den här knappen används när man vill att Eagle automatiskt ska zooma in hela kretskortet
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De här knapparna zoomar in respektive ut
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Den här knappen används för att uppdatera skärmen. Denna knapp bör användas efter att man har flyttat eller tagit bort något.
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Genom att trycka på denna knappen och sedan dra musen (med vänster musknapp intryckt) över ett område så kommer datorn att zooma in de komponenter som ligger

innanför området

Ångra / gör om
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Du kan enkelt ånga något som du har gjort fel, flera steg tillbaka. Du hittar även knapparna Ångra respektive Gör om i det övre verktygsfältet. 

Rita ledningar för ett enkelt kretskort
Nu ska vi börja med att dra ledningar mellan komponenternas ben. De ledningar som du placerar ut kommer att motsvaras av kopparledningar på kretskortet. Det finns några saker du bör tänka på när du ritar ut ledningar. 

· För det första så måste du ha koll på ledningens bredd. En tunn ledning är farligt vid höga strömmar, se i ELFA vilken ledningsbredd du bör använda. 

· Se noga till att inga ledningar går in i varandra.

· Försök att inte blanda för många olika ledningsbreddar, det kan se oproffesionellt ut.

· Ledningar kan dras mellan benen på t.ex. en resistor, men se till att inte ledningen kommer alltför nära resistorns lödöar.

Alla tidigare verktyg du har använt för att kopiera, flytta och radera kan du även använda på ledningar. 

För att rita ledningar så klickar du på den här ikonen i det vänstra verktygsfältet: [image: image21.png]



Innan du börjar rita så ska vi gå igenom de viktiga inställningar som dyker upp i övre delen av fönstret. De ser ut så här:
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Se nu till att du har några komponenter utplacerade och testa att dra lite ledningar emellan komponenternas ben. Glöm inte att prova att högerklicka samtidigt som du drar ledningarna.

Vias

En Via är ett runt hål där man t.ex. kan löda fast en sladd. Att placera ut en via är mycket enkelt, tryck bara på den här knappen i verktygsfältet. [image: image31.png]



Nu dyker det upp lite inställningar i det övre verktygsfältet som ser ut så här:
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Inställningen Diameter och Drill ändrar ytter-och innerdiametern på hålet.

Vill du ha flera hål som ligger symetriskt så är det kanske bättre att du placerar ut en kontaktlist. Kontaktlister hittar du bland komponenterna i gruppen con-lsta och con-lstb.

Övning
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Försök att rita upp följande kretskort.

	Komponent
	Grupp
	Namn

	Batterikontakten
	Battery
	AB9V

	Strömbrytaren
	Switch
	9070-1W

	Motståndet
	Rcl
	0207 / 10

	Lysdioderna
	Led
	LED5MM
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Spara

Du sparar genom att välja File > Save.

Skriva ut

Välj File > Print. Då dyker det upp en ruta.
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Lager
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När du har placerat ut ganska många komponenter på ditt kretskort så kan det vara svårt att se ledningarna bakom alla komonenter. Detta kan du snabbt avhjälpa med att dölja komponentlagret. Om du trycker på den här 
knappen som finns i det övre vänstra hörnet så kommer det upp en lista med alla komponentlager som man kan visa/dölja. Klicka nu på tplace och bplace så att de blåa markeringarna i vänsterkanten försvinner. Tryck sedan OK så ser du att komponentlagret är borta. Vill du ha tillbaka komponenterna så gör du om samma procedur, fast nu vill du ha fram de blåa markeringarna.

En mycket viktig sak att komma ihåg är att alltid ta bort komponentlagret innan du skriver ut på det OH du ska använda vid etsningen. 

Ändring av punkttäthet och måttenhet

Som du kanske har märkt när du t.ex. flyttar en komponent så flyttas den i ”hack” (ej steglöst). Du kan ändra inställningen hur pass tätt de här ”hacken” ska ligga.
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Klicka på 

Då kommer det upp en ruta med ett antal inställningsmöjligheter.
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Att sätta på punkterna eller rutnätet kan vara till hjälp ibland. Testa och se!

Rita ut ledningar (2:a varianten)
Det här sättet att rita ut ledningar är främst tänkt för när man ska använda autorouting (Eagle ritar ledningarna själv), men det kan även vara till hjälpmedel när man har ett ganska avancerat kort som man vill routa själv. Det du gör är att du endast berättar för programmet vad som ska vara ihopkopplat med vad.
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Se till att du har några komponenter utplacerade, sedan trycker du på knappen signal i vänstra verktygsfältet

Klicka sedan på de komponenternas ben som du vill dra en ledning emellan. Som du ser så blir det en gul linje mellan benen, en signal. För att avsluta signalen så trycker du på samma ställe två gånger. Placera nu ut några stycken sådana här signaler. (Det gör ingenting om signalerna korsar varandra eftersom det inte är signalerna du senare ska etsa).

Nu kan programmet hjälpa dig lite med att beräkna kortaste vägar. Detta gör du med en funktion om heter ratsnest. Du hittar den i Tools > Ratsnest. Efter du har gjort detta så har du två alternativ att välja mellan, låta programmet autorouta eller routa ledningarna själv. Det är alltså nu vi ska få fram de riktiga ledningarna som senare ska etsas. Jag rekommenderar att du routar själv, men jag kommer ändå att ta upp hur autorouting fungerar.
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För att routa själv så använder du det här verktyget som heter route 

Klicka på route och ställ in ledningsbredden. Efter det så kan du trycka på en av de gula signalerna. Du kommer då upptäcka att du får fram en blå ledning, precis som förut. Dra nu den blå ledningen så att den går mellan samma ben som den gula. Som du ser så försvinner den gula signalen när du drar den blå ledningen. Gör nu så här med alla ledningarna som du har placerat ut.

Ibland så kan man känna att det inte gick speciellt bra att och att man vill börja om. Du får enkelt tillbaka dina gula signaler genom att använda verktyget Ripup. [image: image43.png]



[image: image44.png]


Klicka på ripup och på en utav dina blå ledningar. Du ser då att den fullt eller delvis blir en gul signal. För att enkelt göra om alla gula signaler till blåa ledningar så markerar du allt med markeringsverktyget       och högerklickar sedan på en utav ledningarna. Testa detta.

Autorouting

Autorouting innebär alltså att du slipper att själv göra om de gula signalerna till ledningar. Se nu till att du har ett antal komponenter med ca 10-20 st gula signaler. Lämpliga komponenter att använda kan du t.ex. hitta i gruppen 74xx-eu. Efter det att du har dragit ut ledningarna så bör du använda ratsnest så att datorn beräknar de kortaste vägarna. Till skillnad från innan så ska du nu klicka på menyn Tools > Auto.. Nu kommer det fram en ruta där du kan ställa in lite olika saker. Se till att alternativen är konfigurerade enligt nedanstående bild.
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Tryck nu på OK och se vad som händer. Om allt har fungerat så ska datorn testa sig fram tills den bästa lösningen. Oftast blir resultatet dock bättre om man routar själv.

Polygoner
Att lägga till polygoner är det sista man ska göra innan man etsar. Man bör ha kollat igenom kortet så att inga ledningar går ihop innan man lägger till polygoner.

Polygoner (månghörningar) används för att fylla tomma oanvända områden på kretskortet. De har ingen inverkan på kortets funktion, utan de används för att etsvätskan inte alltför snabbt ska bli mättad med koppar. Dessutom så ser det väldigt proffsigt ut!

Se till att du har en färdig layout med blåa ledningar och komponenter. Innan vi börjar rita ut polygoner så bör du ha tänkt ut hur ska sätta fast ditt kretskort. Vanligen så sker detta med skruvar eller s.k. distanser. Därför bör du också placera ut hål för där kortet ska fästas. Det gör du enklast genom att använda Vias
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Klicka nu på verktyget Polygon
Du kan nu rita ut något som ser ut som blåa ledningar. Men innan du gör det så ska du ställa in isolate som dyker upp i det övre verktygsfältet när du har klickat på polygon. Isolate är det avstånd som Eagle kommer att hålla mellan ledningar och polygoner. Ett lämpligt testvärde kan vara 0,05 inch (1,27 mm)

Rita en sluten fyrkant (eller någon annan form) runt alla dina komponenter och ledningar. Därefter så väljer du Ratsnest i Toolsmenyn. Du ser nu att programmet fyller ut de tomma områdena med kopparområden.

Placera ut en text
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Medan man designar kretskortet så kan det ibland vara bra att sätta ut lite texter på kortet. Det gör du genom att välja textverktyget i verktygsfältet. När du klickar på text så kommer det upp en ruta där du ska skriva in texten. Sedan är det bara att placera ut den genom att vänsterklicka. Vill du rotera på texten så högerklickar du.

Observera att texten ska bli spegelvänd.

Tips: Se till att du i alla fall har en text på ditt kretskort, t.ex. ditt namn. På så sätt kan du vara säker på att du inte gör fel och spegelvänder kretskortet när du etsar.

Ändra inställningar för ett objekt
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När du har placerat ut ett objekt (t.ex. en ledning) och du senare märker att du vill ändra bredden på den så kan du göra detta på ett smidigt sätt. Klicka bara på knappen change i det vänstra verktygsfältet. Då dyker det upp en meny med flera olika alternativ. Ska du ändra bredden på en lening så väljer du Width och sedan den nya storleken.

Mäta ett avstånd
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Ibland kan man behöva mäta ett avstånd mellan två punkter på kretskortet. Det gör du med verktyget Mark. Klicka på mark och sedan på den första utav de två punkter du vill mäta emellan. Vid den punkten nollställs då avståndmätaren i övre kanten.
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Om du nu flyttar musen till den andra punken så kommer avstånden i x och y-led att anges (Siffrorna inom parentes). Observera att siffrorna anges i inch om du inte har ändrat till mm.

Belysa en ledning
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När du har gjort många blåa ledningar på ditt kort så kan det vara lite rörigt när du till sist ska kontrollera att allt stämmer. Då kan du använda verktyget Show för att belysa en ledning.  Klicka på Show och sedan på ledningen vi vill följa.

Är det något ytterligare du undrar om så är det bara att konfrontera Eagles manual.
Lycka till med ditt kretskort!

Denna manual är skriven av David Lindh 2001.
Eagle är en produkt från Cadsoft. 

Copyright ( David Lindh 2001

davidlindh@hotmail.com
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Den här anger att det är det undre lagret vi vill dra ledningar med. Normalt behöver man inte bry sig om att ändra denna förutom om man ska göra ett dubbelsidigt kort (Kopparledningar på båda sidorna av kortet)
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Här väljer du hur ledningen automatiskt ska dras när du böjer den. Du kan enkelt skifta mellan dessa lägen genom att högerklicka samtidigt som du drar ledningen.
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Här ändrar du bredden på den ledning du ska dra
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Här kan du ändra till streckade linjer. Jag kan inte komma på någon gång då man vill ha det, så låt den stå på Continuous.
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De här knapparna ändrar formen på vian.
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Glöm inte att ange namnet på komponenterna och värdet på motståndet ( 270 ( )
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Mirror�
Skriver ut spegelvänt�
�
Rotate�
Roterar 90 grader�
�
Upside down�
Roterar 180 grader�
�
Black�
Skriver ut i gråskala�
�
Solid�
Skriver ut i svart/vitt�
�
Scale factor�
Utskriftsskala, 1 anger normal storlek�
�
Page limit�
Begränsar antalet utskriftssidor�
�
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Display�
Visar punkter / ett rutnät i On-läge�
�
Style�
Väljer mellan punkter och rutnät�
�
Units�
Bestämmer vilken enhet alla mått ska använda�
�
Size�
Bestämmer avståndet mellan ”hacken”�
�
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